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MeetPro  
Pre-Meet Set-Up and Entry Import 

By Emily Kydd 
 
Welcome all to this manual on the track meet management software MeetPro.  
My name is Emily Kydd and I have been using MeetPro for just over a year now, 
and while it’s a user friendly and intuitive program, like many programs I find the 
Help resources to be fairly lacking.  I’m by no means a tech wizard, just a 
millennial with generationally appropriate computer aptitude, a longstanding 
knowledge of track and field, and an eerie ability to two-finger type.   
 
This manual will attempt to fill in the gaps on how to create a new track meet 
database in MeetPro, as well as importing entries from an online registration 
platform (in this case, TrackieReg) and then seed the meet to be ready for meet 
day.  This will be the first of two MeetPro manuals, the second focusing on day of 
event results management, troubleshooting, and post-event report creation.  
 
Anything I do in my own practice of entry and results management is just that, my 
own and it’s based on my local track scene’s needs. You may need to do 
something different, more or less.  I have no affiliation with MeetPro, and if there 
are any updates or major changes after February 2019, this manual cannot 
speak to them.  
 
So disclaimer aside, let’s get started! 
 
1. Download and License MeetPro 

 
Obviously the first step is to get yourself the MeetPro software and license.  The 
basic Meetpro license can have up to 5 computers on the license and those 
computers can be changed in and out. It’s a yearly purchase for the license, and 
a very simple download process which can be started online here: 
https://tfmeetpro.com/. MeetPro works on both Mac and Windows operating 
systems. You will see from my screen shots that I run on Mac, though when I’m 
at the meet with the system I work on Windows with no issues and no 
differences.  
 
Once you have MeetPro on your computer, you can open it up and follow along.  
 
2. Creating a New Meet 

 
The first time I open MeetPro, a sample meet will be in front of me, presumably 
something to customize and make things easier for me.  This may sound like a 
good idea, but it’s not.   
 

https://tfmeetpro.com/
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I can see that this meet is basic and doesn’t hit any of my needs, so I’m always 
going to make my meets from scratch. That said, once I make a meet, for the 
purpose of this manual the yearly Universal Athletics Track Meet in Surrey British 
Columbia will be our guinea pig, I can easily duplicate it and re-use it the next 
year with minimal changes (unless the meet directors did some crazy fiddling 
with the schedule, we’ll discuss that later). To create a new meet, I will go to the 
top menu bar and choose File>New>New Meet. 
 
This will prompt a pop-up, into which I will enter all of the pertinent information 
about the track meet. I make sure that the start and end dates are accurate, 
and that the Age Up Date in British Columbia is December 31 for that calendar 
year. Other organizations or governing bodies may use a different Age Up Date, 
so check up on yours. The Age Up Date refers to the date at which an athlete will 
change age categories.  For all divisions save for Masters age groups, the age 
up date is December 31. We will talk Masters later… 
 
I always choose Age Group for Type, and then whatever Season I’m working 
on. I always make sure the Track where the meet is happening is correct with 8 
lanes on the straight and 8 on the oval, though some tracks are weird, so if you 
don’t know this for sure, ask! I may be dealing with a meet that needs to Score, if 
so I’ll click that box, and regardless of what type of age groups I choose (I go 
and customize them anyways), I also check Include Mixed. This will insure I 
have age groups that can have more than one birth year in them.  Once this work 
is done, I’ll click Create, and I will have a bright, shiny, and very empty track 
meet database! 
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Now that I have the bones of my database, I’ll deck it out with the customizations 
before I start creating events. 
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3. Customizing the Meet Specifications 
Turning to the top bar menu, I’ll click on Meet, and run through the various set-up 
menus.  Meet Set-Up was my original pop-up to create the meet, but if I need to 
change anything that’s where I can find it.  The second option is Meet 
Information where I can enter more specifics to the location of the meet and the 
technical specs.  This information could be important depending on local, 
provincial, or national regulations, or just to hold the moment in solemn posterity. 
Fill out as much as you need to.  
 

 
 
Next I’ll go back to the Meet menu and select Age Group Set-Up. The dialogue 
box that comes up will depend on what template option I picked in the Meet Set-
Up. Not that it typically matters, since I customize them all anyways. So I click on 
each division, and can edit them into the age group Name, Code and Minimum 
and Maximum Age as I need them to be.  I leave Division 1 empty as it will 
become my Mixed category. One note, if I delete any of the divisions and then 
Add Age Group, those divisions will have higher numbers, out of order and I 
can’t change the division numbers.  Not that this matters, but it is a weird quirk, 
so don’t worry, it’s not you, it’s them.  
 
The naming principles will depend on your track governing bodies, though it is 
IAAF regulation to use the U16, U18, and U20 titles instead of Midget, Youth, or 
Junior.  I split the difference and use both as a lot of folks have not caught up to 
the IAAF and their rule changes.  
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Once I’ve edited all of the age groups to fit the needs of this meet, I can see them 
all and do a scan to make sure that math is correct before closing the box.  
 

 
 
A quick note about Masters: Many local meets do not have specific Masters age 
categories.  Mainly because it’s cumbersome and time consuming. The policy for 
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the Universal Meet is that Masters are very welcome, but they will compete in the 
20+ Open division and not be awarded separately.  If I was creating a meet that 
had all of the Masters 5 year age categories, I would have created each of those 
5 year age categories (35-39, 40-44, 45-49 etc) and I would make the Calculation 
of the Minimum and Maximum Ages to be the First Day of the Meet as 
opposed to the year or the Age Up Date. This is because Masters run in the age 
category they are that day, not that year. Meaning they can go from the 40-44 
bracket to 45-49 group if they have a mid-season birthday.  Which is super lucky 
for June birthdays.  
 
Still in the Meet menu, I have never altered the Lanes or Alleys Set-ups, as the 
default fits just fine for most events. 
 
If the meet is a scored meet, like a high school Championship or a dual meet, 
then I will customize the Scoring Set-Up.  Basically, I will make the amount the 
points awarded to the place as it pertains to the rules of the meet.   
 

 
 
I typically leave the Comps# Set-Up for later in the process, but this is where I 
set the number that the bib numbers will start at (not always 1, often clubs use 
numbers from the year prior, so the First Number could start at 327 or 1934). 
 
The final option in the Meet menu is the Batch Operations, which can basically 
save me time if I need to make the same change to all of the events, like 
changing them from Fastest to Slowest Heat Order or vice versa.  There is not 
a batch operation for all of the options, which is annoying.  
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But now it’s time to create all of the individual track and field events, for each 
gender and for each age group that the meet is offering. Don't worry; it’s not as 
time consuming as it sounds. 
 
4. Adding Events 
Now that I am working on building the meet itself, I will focus on the main 
interface of MeetPro.  There are 6 Blue Tabs at the top of the interface: Events, 
Teams, Athletes, Relays, Seeding, and Enter Results.  I can easily toggle 
between the 6 tabs either by clicking on the tab or by using the keyboard 
shortcuts that can be found in the View menu in the top bar menu.  
 
In the Event tab, I will start off by clicking the green Add New Event button at 
the top left corner of the screen. When the Add Event Dialogue box comes up, I 
will enter all of the information for this event.  What event is first? Well the first 
track event of the first day. I will add events as per the order they arrive on the 
meet schedule for the basic reason that I want the event numbers to be in 
chronological order so that all officials can easily find them and know what comes 
next.  Do not willy nilly create events, always go by the meet schedule, and make 
sure that the events are created in the order with which the meet runs.  For this 
meet, the policy is females first, oldest to youngest. The first event on the track 
on Saturday morning is the 1000m.  So I will create the 11year old Female 
1000m event as Event #1.  
 
I cannot stress enough how much of a headache it is to either create the meet 
events out of order from the schedule or to mistakenly skip an age group or a 
gender and have to add it later.  Either all of the events will need to be moved 
around, or there will be a free flying event out of sequence.   I once spent 5 hours 
fixing a database that someone had built with only one masters event for each 
track and field event, despite it being a Championships with 5 year age groups.  
Don’t do it.  
 
For the purpose of the event numbering system, I create all track events, for the 
entire meet first, in the chronological order of the schedule and then I turn to the 
field events, where the numbering doesn’t matter as much. I will do all of the high 
jump together, then pole vault, etc. so that each field event is clumped together in 
the list and I can easily eye-ball to see if I’ve missed any age groups.  
 
During my event creation phase, I always have the technical specifications 
nearby to refer to them for the hurdle and steeplechase heights, as well as the 
throwing implement weights, as all of this information needs to be included in 
those events.  
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I will select the Type (Track, Field, Relay, or Multi), Gender and Division first. 
To make things easier, check the box that asks to Alternate Genders as that will 
switch it back and forth between male and female after creating each event 
number.  The Event Number auto populates with the next number in the 
sequence, though it is editable if the number needs to be different. (Remember 
the advice above about staying with that meet schedule though.) 
 
Any event that is a timed final will have 1 Round.  If the event has heats, often 
your sprints, there will be 2 rounds.  The screen shot is for the 11year old 1000m, 
so it’s just one round. I will determine how many Positions I want to be possible 
in this specific race, often determined either by how many lanes may be needed, 
or how many bodies can be squished onto the track if it’s distance. You may 
want to check with the meet manager and see what he/she is comfortable with. 
For a distance event with tiny humans, we put a mob of them on the line at once. 
I select what event we are dealing with, Run, Hurdles, Steeplechase, or Walk, 
and then I will Select Distance from the drop down.  If the distance isn’t there, 
such as the 1000m, I will enter it as a Custom Distance.  
 
Since this event only has one round, it only talks of the heat. For non-laned 
events, the Heat Assignment can be Seed Time, with a Heat Order of Slow to 
Fast.  This is to ensure that if there are multiple heats of this timed final, the 
faster times will be grouped in the same heat, with the fastest heat happening 
last.  Leave the Position Assignment as Random. 
 
Regarding the Custom Name, don’t use this.  We have only had problems when 
I have used Custom Names, something about them creates some sort of 
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Pandora’s Box of Impossibility that we haven’t figure our way out of yet.  I will use 
the Note field if I need to make any specifications about an event, like I will for 
the hurdles, Steeplechase and throwing events. I always leave the Gender Label 
as Adult, I guess you could change it to Youth if it’s on a kids meet, but 
whatever, this isn’t the Olympics.  
 
Click Save and I just created my Event #1. Immediately a box for Event #2 will 
pop up, already with the #2 entered, and changed to Male, with the same 
parameters that I did the female race in. I can quickly click through and merely 
change the age divisions and then the distances if the events are all getting the 
same parameters. And all of a sudden I have my first 16 events of the meet!  
 

 
 
For this meet, the 100m races follow the middle distance, so I need to change 
more about the Add Event box when I make this transition. In the Universal 
Meet, the 100M and the 60M events have two rounds, a heat and a final. So I will 
change the Rounds to 2 and select 100 from the Distance drop down. By 
adding a second round, options about both the heat and the final are presented. 
The Heat Assignment will be Serpentine, with the Heat Order being Slow to 
Fast.  The Serpentine will ensure that the fastest seed times will not all be in one 
heat, but will be spread across the heats. You never want to have a “fast heat” in 
the preliminary round as one of the fastest seed times may not make the final. 
The serpentine puts the fastest time in the last heat, the second fastest time in 
the second to last heat, the third fastest time in the third heat and so on. Like the 
1000m event previously, we want the person with the fastest seed time to run in 
the last heat. Theoretically, if nobody lied on their seed times (which people 
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always do, so don’t be surprised!) the fastest people will end up in the finals 
regardless of what heat they’re in.  
 
Speaking of advancement, I can select how advancement will occur, whether it is 
through Time or Place/Time.  Time typically will refer to the 8 fastest times, 
regardless of what heat they came from. Place/Time refers to typically the first 1 
or 2 finishers from each heat with the next 2/3 fastest times, all depending on 
how many heats there are based on IAAF rules. So if there are 5 heats, it would 
be the winner of each heat, and then the next 3 fastest times. 
 

 
 
I always leave the Lane Assignments as Standard Lanes. The Heats box, third 
from the bottom of the page, is where I can change the amount of finals there 
may be. This is common in bigger meats, to have an A&B final for bigger age 
divisions, to give more athletes a second round. It doesn’t happen much in local 
meets. Again, don’t use Custom Name, and if I need to specify anything I’ll use 
the Note field.  
 
Once I get to any Hurdles events, I’ll change the Event to Hurdles, enter my 
distance, and then in the Note field, state what the height of the hurdles will be.  
This specification is required in the official results, especially if any of the times 
are going to stand up for records or teams.  
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I’ll change the Type of event to Field, and then select in the Event drop down 
which one I’m looking for. I’ll determine how many positions I want to be in the 
event. For this example, if this High Jump event had more than 15 entered, it 
would automatically create two heats (or flights as is more commonly used 
terminology, but it’s all semantics).  I set the Heat Assignment, Order, and 
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Position Assignment all to Random, as per the rules. Some think the best seed 
height or distance should jump or throw last. But alas, no. The rule book dictates 
randomness, as does the official who has nagged me about this before.  
 

 
 
 
If the meet offers relays, I will create each age group’s relay, again, just by 
changing the Type of event at the top and then entering the distance.  The 
language for distance in this menu is not 4x100, but 400m relay. It’s weird, but it 
does read properly in the event list.   We’ll deal with relays more later on. Relays, 
grrrr.  
 
For the last general set-up for event creation, all Throwing events need to have 
the weight of the implement being thrown stipulated in the official results, much 
like the hurdles and the steeplechase heights.  So for all throwing events 
(Weight/Club Throw, Javelin, Shot Put, Hammer, and Discus), I will put the 
weight of the implement for that age group into the Note field. The technical 
specifications can surely be found on your local athletics governing website. 
 



13 
 

 
 
Now that I have created all of my events, I can return to my Event tab and see 
the entire list of events. I can filter them by only women, men or both, only track, 
field, relays, multi or all. I can also click along any of the headings in light blue at 
the top of the list (No., Name, Gender, Division etc) to reorder the events based 
on sorting that heading.  The one I will use the most is the Number heading, as 
for some reason MeetPro always wants to reorder the events by putting the 
shortest distance at the top, instead of the number. I don’t want to order it with 
the 60m first all the time!  
 
5. Session and Schedule Creation 

 
Now that I have created all of my events, it’s time to divide them into Sessions 
and create the Schedule inside the database.  
 
Sessions are ways to divide a track meet to more easily keep track of where 
everything is. I typically create sessions based on day and event. For a two-day 
weekend meet, I’ll create 4 sessions: Saturday Track, Sunday Track, Saturday 
Field, and Sunday Field.  This way I can filter what I’m looking at to only be what 
I need for that day when I’m doing results.  From the Event tab, I’ll click on the 
dark blue button on the top right corner called Edit Sessions.  
 
At this point, all of the events are unscheduled, meaning they haven’t been 
assigned to a session or have a time attached to them. I will start by clicking Add 
New Session, and creating 4 sessions as I said previously. 
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I will then open up the first session, so Saturday Track, and drag, in order of the 
event numbers, all of the track events happening that day from the left had box to 
the right hand one. This is a very important step as the Photo Computer Operator 
will use this schedule in order to pull up the next event by click “Next Event” in 
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the photo software. MeetPro will also print out the heat sheets in the correct 
order for the start line and the finish line officials. This is a huge time saver for all 
concerned. 
 

 
 
This process can be kind of glitchy, so play around with the tab button and the 
mouse to try to do this as efficiently as the program will let you. Again, events 
rearrange themselves for no particular, yet quite annoying, reason.   
 
Once I get all of my Saturday track events into the Saturday schedule, I’ll go 
down the line and add times.  The times need to keep the event numbers in 
chronological order and mirror the schedule as closely as possible. This is 
difficult as most schedules will have all 1500m’s starting at 11am for example, yet 
obviously the gun for all age groups won’t go at 11am, yet I can’t have two 
events as single time or else it messes things up with the Finish Lynx software.  
 
So I clump them as close to the time specified as possible (11am, 11:02am, 
11:04am etc). This can be a headache later because anal people will come up at 
the meet saying “But the schedule says I run at 11am, why does the start list say 
11:17?!?! This is when you point that person to the meet director and try not to 
roll your eyes, which is honestly really difficult for me. I have a problem.  
 
I don’t bother putting times into the field events, but I do divide them between 
Saturday and Sunday, only so that I can filter them out when I’m doing results 
and find the event I’m looking for easier.  
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At this point, my database is ready and there is not much more I can do until the 
entry deadline closes. The process I have just gone through has created a shell 
of a meet that now needs to be populated with athletes, teams, and entries. 
Ideally, those three things will come from a meet registration platform like 
TrackieReg or similar.  
 
 Not so ideally, I will manually enter athletes by creating athlete and team profiles 
and entering them into the individual events they want to go into.  This is not 
likely to happen, because it’s 2019 and manual entry is mind numbing.  So at this 
point we will work on the assumption that I will be downloading my information to 
populate the database from TrackieReg with a minimal amount of manual entry 
for late entries.  
 
So at this time, I’ll take a break, refill my pinot grigio, and play with my cat.  
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6. Entry Import 
 

Now that several weeks or months have gone by (I typically do my database 
creation early to spread out the work), it’s time for the entry deadline. The day 
after the deadline, which is typically at 11:59pm, I’ll go into TrackieReg and 
export the entries from the meet registration site. To go into detail about Meet 
Registration sites, refer to my manual on TrackieReg: Creating a Meet 
Registration Site.  
 
In the Account page, the event for this meet is listed.  To export the entry data, I 
will click on the green Options button, which will then present a drop down 
menu.  I’ll choose the Export Data option.  
 

 
 
A dialogue box comes up asking for some parameters for the export. MeetPro is 
built in the style of another meet management software, Hytek. So I check the 
box for Hytek Meet Manager.   
 
The main thing I need to be aware of when doing this export in the Hytek format, 
is that the Divisions in TrackieReg and in Meetpro have to match.  That means I 
have to go into my TrackieReg meet site, and edit the age group division 
numbers to match whatever they may be in MeetPro.  For example, JD 9 year 
olds are Division 2 in TrackieReg, but they are division 6 in Meetpro.  It really 
doesn’t matter whether I change MeetPro to match or TrackieReg to match, 
either way, as long as the same age groups have the same division designations, 
all will be well.  
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Once I’m sure that my Divisions match, I can click Export and a download will 
start. Wherever the download ends up, (usually the “Downloads” folder,) I’ll drag 
it onto my desktop for easy access.  
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Once the file is on my desktop, I’ll go into my database for this meet in MeetPro 
and I’ll click in the top menu bar File > Import > Semi-Colon Delimited File.  I 
will then select the file from my desktop.  
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A small import box will pop up. I will uncheck the Add Missing Events box 
because if there is anything missing I want to know about it add it myself), and 
typically leave the Reg # as DA ID. Not that it really matters since we’re in 
Canada.  
 

 
 
Once I hit import, the import will begin. Sometimes it stalls half way through, I just 
shut down the program and start it again. If there are any mistakes made 
somewhere along the line, like maybe I forgot to create a shot put even for the 13 
year old girls, a list of Exceptions will be produced in PDF format.  
 
This exception sheet can be very useful if the meet is offering paralympic events.  
I don’t ever create divisions or events for para ahead of time.  I don’t because it’s 
time consuming, and there are often not many para athletes at a meet. Instead, I 
wait to see who entered, what para class they are in, and what events they are 
competing in, and then I will create events and divisions specifically for the 
athletes who are registered.  
 
So at this time, I now have a database full of athletes, as I can see by the 
numbers in the Entries column to the far right of the screen.  
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I can also see the athletes in the Athletes Tab and the teams in the Teams Tab. 
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The teams can be edited as desired, though normally the only ones I would edit 
would be any that are not obvious by the first 8-9 letters, as there are certain 
reports where the team name is cut down to this amount of characters. For 
example I may edit the Short Names for teams like Vancouver Thunderbirds 
down to Van Thunderbirds or the Vancouver Olympic Club to VOC.  
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I may also edit the team names that are not capitalized. For no real reason 
besides that it suits my delicate sensibilities.  
 
7. Adding Athletes 
 
Often athletes will want to late register.  Depending on the meet, this may or may 
not be permitted. If I was to set the rules, I would say no late entries after the 
deadline, but you can show up the day of and do a day of registration. The 
reason I say this is because by doing late entries when the athlete is not right in 
front of you, they may not show up for the meet, and then you would have 
wasted your time corresponding with them and doing manual data entry, and 
they don’t even cough up any cash.  
 
But regardless of when I do late entries, either before the meet or at the meet, I 
inevitably have to manually add athletes.  To do this I click on the Athletes tab of 
MeetPro and click onto the green Add New Athlete button in the top left hand 
corner.  
 

 
 
I will populate the fields with the First Name, Last Name, Team (from the Drop 
down), Date of Birth, and the Athletics Registration Number (in the DA field). 
If the team doesn’t exist, that means they are the first from their team to enter the 
meet, and I will need to go to the Team tab and add the team.  I make sure that 
the Age that autopopulates with the entry of the DOB is correct, ensuring that the 
athlete will be eligible to compete in events for their proper age category.   
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I will then enter them into their desired events. I will enter a seed time only under 
duress as most meets have a policy that say any athlete who late enters will not 
be seeded, because, you’re late, so you get what you get!  I can go back and edit 
the athlete later as well if need be by double clicking on the athlete from the 
Athlete tab.  
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I can also add existing athletes, aka athletes who are already in the meet, into 
more events by finding them in the Athlete list either through the filters or 
through the Search function.  
 

 
 
 
8. Customizing Relay Teams 

 
Relays are a pain in the ass. But people love them, so they remain legal events 
in the sport of Athletics.  Thankfully, MeetPro actually makes organizing relays 
fairly easy.  Earlier, I created whatever relay events I needed to.  Then with the 
import, those relays have been populated.  Some meets, like this one, only do a 
mixed relay, which makes things easy, everyone runs together, and I merely go 
into the Relay tab and maybe edit the names of the Age Groups of relays to 
simply distinguish them from each other to make things easier on the day of 
meet.  
 
I can also add athletes to each relay team by clicking first on the team in the 
large centre box and then double clicking on the Eligible Athletes in the lower 
left hand corner. Only athletes from the team highlighted would appear in this 
eligible box, and if it were not a mixed relay, only athletes of that age group 
would show up. I can drag the names around in the Relay Order box if it is a 
meet where relay order matters, or even if it doesn’t matter but people are 
beyond anal.  
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9. Seeding Events 
 
The last major step in pre-meet work is to Seed the events. Seeding an event 
means that I’m taking all of the entries for each event and putting them into heats 
and lanes. MeetPro typically does this pretty well, as long as I set up the events 
properly to begin with.  This is where all of those specifics during Event Creation 
about Heat Assignment, Serpentine, Positions, and Order all come into play.  
 
The Seeding tab has the list of every event that has entries in it, and I can see 
on the right hand side how many entries there are. The fourth column in shows 
which events have been seeded and which are still un-seeded.  
 
I only check off 6-10 events at a time, more to make sure my software/computer 
don’t freeze. I don’t need a 9 year old MacBook thinking too hard. Once I check 
off one or more events, I click the green Seed Selected button at the top left 
corner.  
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A small dialogue box will pop up and depending on the event will ask whether or 
not I want to do Auto Team Split.  This ensures that if 3 athletes from the same 
club are in that event, the program will attempt to have them in separate heats, or 
at least not all right beside each other on the track. I also check this.  It will also 
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ask me how many heats I want, though very rarely have I ever had to change this 
box because MeetPro can read how many entries there are and depending on 
how many Positions this event has assigned to it, MeetPro will do that simple 
logic itself. I then press Start. 
 

 
 
The program seeds the heat(s) as per the heat and lane assignment stipulations 
and depending on the seed times given.  For the above example, only one 
athlete gave a seed time, so he gets the best lane. I can move people around as 
I wish, either to split up team differently, or maybe I know something about this 
track that we want to avoid lane 1 or lane 8 so I move athletes out when I can.  
 
At this point, I can also “Add” another Heat, and drag athletes into this event 
from the list of Eligible Athletes to the right of the screen.  
 
I can double click on an athletes name and the program will prompt me to 
Scratch that athlete and confirm.  
 
The program generally does a good job of making sure the heats are balanced 
and properly seeded, though it does require a human eye since every so often I 
come across a laned event with 9 entries, two heats, and only 1 person in the 
last heat. Not cool. I can also eye ball any absolutely ludicrous seed times, like 9 
year olds running the 100m in 10 flat (or more likely older competitors lying about 
their seed times, this is when local knowledge comes in handy).  
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I will repeat this process through all of the events, laned and non-laned for the 
track, relays, and field events. I keep people out of lane 1 and 8 when I can, just 
because people typically hate those lanes and I’m pre-empting having to do it at 
the behest of a starter’s assistant down the line. I may also look at events that 
may possibly be combined (like if there are only 3 U20 women and 3 U18 women 
registered in the 400m). I would then, again to make things easier later, place 
athletes in lanes so that the two events can be run on the track as one (with the 3 
U20’s in lanes 5, 6, and 7 while the 3 U18’s are in 2, 3, and 4). But this is not 
required, it’s only a trick I’ve picked up along the line that can limit headache later 
on.  
 
By the time I have gone through and seeded all of the events, the meet is pretty 
much ready to go. Only a couple of final touches and then it’s time to pack my 
track bag! 
 
10. Last Steps 

 
The last thing I will do before publishing reports to send to the meet director is go 
back to the Competition #’s Set-Up in the Meet menu of the top bar menu of 
MeetPro.  With any late additions, there are sure to be athletes from the same 
team with numbers out of sequence and we want all of the athletes from one club 
being assigned numbers grouped in sequential order. This makes it far easier to 
make club packages.  
 
In the Competition # Set-Up, I will make sure it’s set to the correct Starting Bib # 
(ask the meet director to make sure), set the Alpha By: Team and then click on 
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Clear All Competition #’s. Immediately after, I will click Assign Comp #’s and 
all will be right with the numbers.  
 

 
 
Finally, now that everything is entered and the events are seeded, I will create a 
few reports with the Reports drop down from the MeetPro top bar menu. At this 
point, the meet director will want two things, the Start Lists and the Entry List 
broken down by Team. 
 
For the former, I will simply click on Start Lists from the drop down.  A dialogue 
box will prompt, asking me for various wants and desires. I normally make two 
sets of start lists, one in PDF and one in Text. The PDF looks better and is easier 
to read, but the text can be copy and pasted. At this point I would include ALL for 
Gender, Type, Relay, and Round, and I would set the Order to Event # so the 
list is more or less in chronological order. For the check boxes at the bottom, I 
specifically leave off most of the information as to not clutter the information and 
the pages and also because the more info I give the more uninformed questions 
people will have, like “but my event is scheduled for 11 but the start lists says 
11:17?!?!” and “my child is 11 but the start list says his age is 12!?!” People have 
no faith anymore.  Trust me, it’s correct.  
 
What I do leave on are the Show Seeds, the Event Notes (for those heights and 
weights), and maybe the Advancement Criteria.  
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The other Report needed at this time is the Entry list in order to make up the 
packages of numbers. I do this from the Reports > Entries > By Team.  For the 
box that comes up, I check off Comp #’s, since that’s the raison d’etre of this 
report, so people know what number belongs to who, and I also check Number 
Athletes so with an easy glance coaches can see how many athletes they have 
entered.  I typically create two of these reports, both in PDF, but one with Page 
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Breaks between Teams and one without. This is so that the one with page 
breaks can go into each envelope with the numbers and be given to the clubs for 
handing out numbers, while the one without page breaks can be kept by the 
registration desk for simpler handling.  
 
I do not create the finish line sheets or score field sheets prior to arriving at the 
meet, typically because there are late entries and day of event entries and then I 
have to redo them anyways.  
 
My last task before the meet is to fill a flash drive with the MeetPro database, 
start lists, athletes lists, meet package, and meet schedule. I’m the only one at 
this point with the database, so it’s a pretty important thing with which to arrive.  
The schedule and the package are always useful to have, and I will normally print 
out some schedules to hand out to people on that first morning.  
 
And with that, I’m ready for the meet! Unless it rains, and then I have to pack 
more clothing. 
 
For more information on my track meet routine (including helpful tips and some of 
my humble opinions), and a breakdown of my tasks before, during, and after a 
track meet as the Meet Secretariat, please refer to my delightful and enlightening 
commentary of the role in my document Entries and Results Management 101 
– From the Secretariat’s Seat.   
 
I have also created two companion manuals to this one, TrackieReg – Creating 
a Meet Registration Site and MeetPro – Day of Event Results and Meet 
Management, as well as a Meet Secretariat Checklist.  
 
I wish you, the reader, the best of luck with your Meet Secretariat hopes and 
dreams. Armed with all of this information and the knowledge that I have 
gathered, sometimes through trial, error, or crisis, I’m confident that the reader is 
ready to hit the track!  
 
 


